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About This Guide
· Overview

· Conventions

· About Quest Software

· Contacting Quest Software

· Contacting Customer Support
Overview

This document has been prepared to assist you in becoming familiar with Recovery Manager Forest Edition. The User Guide contains the information required to install and use this product. It is intended for network administrators, consultants, analysts, and any other IT professionals using the product.

Conventions

In order to help you get the most out of this guide, we have used specific formatting conventions. These conventions apply to procedures, icons, keystrokes and cross-references.

	Element
	Convention

	Select
	This word refers to actions such as choosing or highlighting various interface elements, such as files and radio buttons.

	Bolded text
	Interface elements that appear in Quest products, such as menus and commands.

	Italic text
	Used for comments.

	Bold Italic text
	Introduces a series of procedures.

	Blue text
	Indicates a cross-reference. When viewed in Adobe® Acrobat®, this format can be used as a hyperlink.
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	Used to highlight additional information pertinent to the process being described.
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	Used to provide Best Practice information. A best practice details the recommended course of action for the best result.
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	Used to highlight processes that should be performed with care.

	+
	A plus sign between two keystrokes means that you must press them at the same time.

	| 
	A pipe sign between elements means that you must select the elements in that particular sequence.


About Quest Software, Inc.
Quest Software, Inc. delivers innovative products that help organizations get more performance and productivity from their applications, databases and Windows infrastructure.  Through a deep expertise in IT operations and a continued focus on what works best, Quest helps more than 18,000 customers worldwide meet higher expectations for enterprise IT.  Quest’s Windows Management solutions simplify, automate and secure Active Directory, Exchange and Windows, as well as integrate Unix and Linux into the managed environment. Quest Software can be found in offices around the globe and at www.quest.com.
Contacting Quest Software

E-mail:

info@quest.com
Mail:

Quest Software, Inc.


World Headquarters


5 Polaris Way


Aliso Viejo, CA  92656


USA

Web site:
www.quest.com
Please refer to our Web site for regional and international office information.
Contacting Quest Support

Quest Support is available to customers who have a trial version of a Quest product or who have purchased a commercial version and have a valid maintenance contract. Quest Support provides around the clock coverage with SupportLink, our web self-service. Visit SupportLink at http://support.quest.com.
From SupportLink, you can do the following:

· Quickly find thousands of solutions (Knowledgebase articles/documents).
· Download patches and upgrades.
· Seek help from a Support engineer.
· Log and update your case, and check its status.
View the Global Support Guide for a detailed explanation of support programs, online services, contact information, and policy and procedures. The guide is available at: http://support.quest.com/pdfs/Global Support Guide.pdf.
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· Prerequisites for Using Recovery Manager Forest Edition

· Introducing Recovery Manager Forest Edition
· Features and Benefits

· Licensing

· Permissions Required to Use the Application

Prerequisites for Using Recovery Manager Forest Edition

This paper assumes that the specialist (e.g. an Active Directory administrator) responsible for deployment of the application is aware of fundamental Active Directory concepts and the importance of operations master roles (also known as a flexible single master operation or FSMO), such as schema master, domain naming master, RID master, PDC emulator, and infrastructure master. In addition, the Active Directory administrator should be aware of how to backup and restore Active Directory with Quest Recovery Manager for Active Directory and have performed this procedure in a lab environment on a regular basis.
Introducing Recovery Manager Forest Edition

Recovery Manager Forest Edition is designed to recover a Windows Server 2003 Server Active Directory forest, if forest-wide failure renders all domain controllers in the forest incapable of functioning normally. The use of Recovery Manager Forest Edition will allow you to minimize the downtime caused by the corruption or improper modification of Active Directory forest and data.

In general, a forest recovery is necessary if none of the domain controllers in the forest can function normally or if the corrupted domain controllers can spread dangerous data to new domain controllers. 

Some examples of forest-wide failures include:

· None of the domain controllers can replicate with its replication partner.

· Changes cannot be made to Active Directory at any domain controller.

· New domain controllers cannot be installed in any domain.

· All domain controllers have been logically corrupted or physically damaged to a point that business continuity is impossible (for instance, all business applications that depend on Active Directory are non-functional).

· A rogue administrator has compromised the Active Directory environment.

· An adversary intentionally or an administrator accidentally runs a script that spreads data corruption across the Active Directory forest.

· An adversary intentionally or an administrator accidentally extends the Active Directory schema with malicious or conflicting changes.

Recovery Manager Forest Edition simplifies and automates the process of Active Directory forest recovery. Recovery Manager Forest Edition automates the manual tasks involved in a forest recovery, remotely quarantines corrupt domain controllers, and simultaneously restores domain controllers from backup to speed the overall recovery and restore business operation quickly.
Features and Benefits

Recovery Manager Forest Edition provides the following features.
Simplified Restoration of Active Directory Forest
With the application console, you can remotely recover selected domain controllers in the forest. No operator intervention requires.

Automating Manual Operations

Using native tools to recover a forest requires numerous and lengthy manual steps repeated on each domain controller in the forest. This process results in a very slow and tedious recovery prone to human error. Recovery Manager Forest Edition automates those numerous manual steps not only saving vast amounts of time but also eliminating the risk of human error.

Remote Quarantine
Recovery Manager Forest Edition automatically and remotely quarantines corrupt domain controllers so that those individual domain controllers won’t replicate with the newly restored environment.

Simultaneous System Recovery
All domain controllers in your forest can be restored simultaneously from one centralized location, using backups created with Recovery Manager, eliminating the need to manually interface with each domain controller separately saving a significant amount of time and effort.
Test Mode
Using this feature, you can test your forest recovery project before performing the recovery procedure. No changes to the forest infrastructure will be made.
Restoring Domain Controllers from Backup

The Quest Forest Recovery console allows you to restore all domain controllers from backups created by Recovery Manager for Active Directory, if available. Backups should be recent enough to avoid data loss, but taken before the corruption occurred to Active Directory. Backups must be created with version 7.6 of Recovery Manager for Active Directory after the Forest Edition was installed.

You can specify a backup to be used to restore the domain controller or let Recovery Manager Forest Edition select a backup using the specified criteria.

Licensing

Recovery Manager Forest Edition licensing is based on the total number of user accounts in the Active Directory forest to be recovered. A license key file for Recovery Manager Forest Edition specifies the licensed number of user accounts.

If the actual number of user accounts exceeds the licensed number, Recovery Manager Forest Edition does not cease functioning, but the product will return a warning message each time you recover the forest. In this case, you must install a new license key file purchased from Quest Software.

Permissions Required to Use the Application

The requirements for the user accounts that Recovery Manager Forest Edition uses are as follows.

Console Account

The account under which the Forest Recovery console is running must have the Read access to the Recovery Manager backup registration database. In addition, Recovery Manager for Active Directory must be installed on the computer that runs Recovery Manager Forest Edition.

Domain Controller Connection Account

Recovery Manager Forest Edition must use the built-in Administrator account to access domain controllers to be recovered.
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Understanding Recovery Manager Forest Edition

· Developing a Custom Forest Recovery Plan

· Deciding When to Perform Forest Recovery
Developing a Custom Forest Recovery Plan
When planning for Active Directory forest recovery, you should first have a detailed topology map of your forests. The map should list all the information about the domain controllers, such as their names, FSMO roles and backup status, and the trust relationships between them.
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	To perform a forest recovery, an Administrator account password is required for each domain in the forest. It is a good practice to archive the Administrator account password history in a safe place. 


Because of the complexity and critical nature of the forest recovery process, it is strongly recommended that Active Directory administrator observe the following rules to prevent the forest failure:

· Use only reliable and tested hardware, such as hard disks, uninterruptible power supply, etc.

· Test any new configuration in a test lab before deploying it in your environment.

· Ensure that each domain in the forest has at least two domain controllers.

· Keep detailed logs about the health state of Active Directory on a daily basis, so that in case of a forest-wide failure, the approximate time of failure can be identified.

· Regularly back up all domain controllers in the forest with Quest Recovery Manager.

· Install the Forest Recovery agents on all domain controllers in the forest.

· Using the Quest Forest Recovery console, create a recovery project for your forest. Test the forest recovery project on a regular basis, especially when there are membership changes to the Enterprise Admins or Domain Admins group. This helps ensure that the IT staff fully understands the forest recovery plan.
Backing Up Domain Controllers with Quest Recovery Manager Forest Edition
Quest Recovery Manager Forest Edition can restore domain controllers only using Active Directory backups created with Recovery Manager for Active Directory. That is why you should back up domain controllers in the forest on a regular basis using the above mentioned application.

It is a good practice to create a Computer Collection that includes all domain controllers in the forest and back up the Collection each time you make changes to the forest infrastructure.

In addition, you can ensure that the Forest Recovery agents are installed on all domain controllers the Collection includes. To do this, open the Recovery Manager MMC console, and perform the following steps:

1. In the console tree, expand the Computer Collections node, and then select the Computer Collection that includes all domain controllers in the forest.

2. On the Action menu, click Properties, and then click the Agent Settings tab.

3. On the Agent Settings tab, select the Ensure Forest Recovery agent is deployed check box. When finished, click OK.

If the Ensure Forest Recovery agent is deployed check box is selected, while backing up the Computer Collection, Recovery Manager verifies whether the Forest Recovery agent is installed on each domain controller the Computer Collection includes. Recovery Manager automatically reinstalls the agent, if necessary.

For more information about how to use Computer Collections, refer to the Manage Computer Collections section in the Recovery Manager Help.

Deciding When to Perform Forest Recovery
In general, a forest recovery is necessary if none of the domain controllers in the forest can function normally or if the corrupted domain controllers can spread dangerous data to new domain controllers. 

Some examples of forest-wide failures include:

· None of the domain controllers can replicate with its replication partner.

· Changes cannot be made to Active Directory at any domain controller.

· New domain controllers cannot be installed in any domain.

· All domain controllers have been logically corrupted or physically damaged to a point that business continuity is impossible (for instance, all business applications that depend on Active Directory are non-functional).

· A rogue administrator has compromised the Active Directory environment.

· An adversary intentionally or an administrator accidentally runs a script that spreads data corruption across the Active Directory forest.

· An adversary intentionally or an administrator accidentally extends the Active Directory schema with malicious or conflicting changes.
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	When symptoms of a forest-wide failure appear, such as in event logs or other monitoring solutions, work with Microsoft Customer Support Services (CSC) to determine the cause of the failure, and evaluate any possible remedies.
Because of the complexity and critical nature of the forest recovery process, total Active Directory forest recovery should be the last option. Please consult CSC before you take a definitive decision.
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Getting Started

Recovery Manager Forest Edition User Interface

Recovery Manager Forest Edition is implemented as a user-friendly console to ensure intuitive operation and close integration with the Windows operating system.

To start Recovery Manager Forest Edition, click Start, point to All Programs -> Quest Software-> Recovery Manager for Active Directory Forest Edition, and then click Recovery Manager for Active Directory Forest Edition. When started for the first time, the application launches the New Recovery Project wizard. The following page is displayed:
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The wizard allows you to specify how to retrieve the infrastructure of the forest to be recovered. For more information, see "Using the New Recovery Project Wizard".

After you create a recovery project, the application console is similar to the following window:
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The main viewing area of the window is divided into the following panes.

· Project Summary: Summarizes information about the forest to be recovered.

· Project Settings: Provides a list of all domain controllers in the forest. The domain controllers can be grouped by domains or by sites. In the list, each entry has the following fields:

· DC- Displays the domain controller DNS name.

· Recover - When selected, causes Recovery Manager Forest Edition to recover the domain controller.

· Domain - Displays the name of the domain to which the domain controller belongs.

· Site - Displays the name of the site to which the domain controller belongs.

· Backup - Displays the date and time when the backup was taken (used only for the Restore from backup method).

· Domain Controller Recovery Progress: Displays the progress of the recovery or test process for the domain controller currently selected under Project Settings.

· Domain Controller(s) Recovery Settings: The information in this pane changes accordingly when you select a domain controller under Recovery Settings. The following elements allow you to specify the recovery settings applied to the selected domain controller:

· Recover DC(s) - When selected, causes Recovery Manager Forest Edition to recover the domain controller.

The elements under DC access options allow you to specify the following settings:

· User Name: Provides a space for you to type the user logon name to be used to access the domain controller.

· Password: Provides a space for you to type the user password.

· DSRM Administrator: Provides a space for you to type the logon name of the Directory Service Restore Mode Administrator.

· DSRM Password: Provides a space for you to type the password of the Directory Service Restore Mode Administrator.

The elements under Backup information display information about the selected backup if any and allow you to specify some backup related settings:

· Age: Displays the backup age (in days)

· Backup file name: Displays the backup file name

· Media: Displays a path to the folder where the backup file resides.

· Change: Click this button and then complete the Select Backup dialog box to select another backup file.

· Encryption: Indicates whether the backup is protected with a password (Yes or No)

· Protection password: Provides a space for you to specify the backup protection password.
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	Under Domain Controller(s) Recovery Settings, you can specify settings for multiple domain controllers at the same time by multiple-selecting them in the Project Setting section of the Console.


The elements under Backup access options allow you to specify credentials the application uses to access backups stored on network shares:

· User name: Provides a space for you to type the user logon name that Recovery Manager Forest Edition will use to access the network share that contains the backup file. This user must have the Read access to that network share.

· User password: Provides a space for you to type the user password.

The console also contains command menu that includes the following items:

· File: The File menu provides the following commands:

· New Project - Starts the New Recovery Project wizard.

· Open Project - Opens an existing recovery project.

· Save Project - Saves the current recovery project to the specified XML file.

· Exit - Closes the Forest Recovery console.

· Tools: The Tools menu provides the following commands:

· Launch Recovery Manager for Active Directory: Allows you to start Recovery Manager for Active Directory.

· Test: Runs the current recovery project in the test mode. See "Using the Test Mode".

· Start Recovery: Runs the current recovery project.
· Finalize Recovery: Performs the post-recovery steps (see "Post-Recovery Steps," later in this paper).
· Abort: Terminates the execution of a current recovery project or a test operation.

· View Report: Displays the report on the recovery or test operation.

Creating or Opening a Recovery Project

The recovery project is where you manage the recovery of all the domain controllers in the forest to be recovered. The project also contains the list of domain controllers and settings you set up, such as the method of recovery for each domain controller, the credentials that the application uses to access the domain controller, etc. The project file (.FRPROJ file) contains information about the content and properties of your project.

Using the New Recovery Project Wizard
The New Recovery Project wizard helps you create a new recovery project. The wizard retrieves the list of all domain controllers in the forest to be recovered and saves that list in the project file. You can select the way the wizard uses to retrieve the forest infrastructure. The following options are available:

· Connecting to any available domain controller in the forest

· Using an Active Directory backup taken from any domain controller in the forest. 
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	You can use only backups created with Recovery Manager.


To create a recovery project

4. On the File menu, click New Project. The New Recovery Project wizard starts.

5. On the Retrieving the Forest Infrastructure page, specify how to connect to the forest to be recovered.

6. Follow the provided instructions to complete the wizard.

7. On the File menu, click Save Project and then complete the Save Forest Recovery Project dialog box.
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	All recovery projects must be protected with a password. After you specify the project name in the Save Forest Recovery Project dialog box, the application displays the Set the Project Password dialog box that allows you to specify the project protection password.


Opening an Existing Recovery Project

To open an existing recovery project

8. On the File menu, click Open Project.

9. Use the Open Forest Recovery Project dialog box to open the .FRPROJ file that contains information about the content and properties of the project.

	[image: image11.png]



	All recovery projects are protected with a password. After you select a project with the Open Forest Recovery Project dialog box, the application displays the Set the Project Password dialog box that allows you to specify the project protection password.


Using the Test Mode

To ensure that you can recover your forest with a minimum downtime, it is recommended you regularly test the forest recovery project using the test mode feature provided by Recovery Manager Forest Edition. 

When testing the forest recovery project, Recovery Manager Forest Edition polls domain controllers to be recovered and the Forest Recovery agents installed on those domain controllers. The application verifies whether the Forest Recovery agent is installed and running. The application also ensures that the specified credentials allow the Forest Recovery agents to access the domain controllers and backup files. The results of those queries are reported to Active Directory administrator.

The use of the test mode makes the forest recovery and troubleshooting easier, because it allows you to detect the possible problems you might face.

To test the recovery project

10. Create a new recovery project or open an existing project. 
11. On the toolbar, click Test.

12. To view the report on the test results, on the toolbar, click View Report.
Using the Forest Recovery Agent

Recovery Manager Forest Edition employs Forest Recovery agents to restore Active Directory on target domain controllers to be recovered. Therefore, the Forest Recovery agent must be installed on each domain controller in the forest to be recovered. 
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	If the Forest Recovery agent was not installed on a target domain controller before a disaster occurred, the application cannot recover that domain controller.


Installing the Forest Recovery Agent

You can manually install the Forest Recovery agent on a target domain controller using the Forest Recovery Agent setup program.

You can also have Recovery Manager for Active Directory install the agent, if necessary, when you back up a Computer Collection that includes the target domain controller.

To install the Forest Recovery agent with the setup program
13. On the target domain controller, run recoveryagent.exe, located in the folder "Setup" on the Recovery Manager Installation CD.

14. Wait while the setup program completes the installation.

To have Recovery Manager automatically install the Forest Recovery agent if necessary

15. With the Recovery Manager snap-in, create a Computer Collection, and add the target domain controller to that Collection.

16. In the Recovery Manager console tree, select the created Computer Collection, and then click Properties on the Action menu.

17. In the Computer Collection Properties dialog box, click the Agent Settings tab.

18. On the Agent Settings tab, select the Ensure Forest Recovery agent is deployed check box.

19. When finished, click OK.
Recovering Active Directory Forest
The application allows you to restore a domain in the forest to its state at the time of the last trusted backup. Consequently, the restore operation will result in the loss of at least the following Active Directory data:

· All objects (such as users and computers) that were added after the last trusted backup

· All updates made to existing objects since the last trusted backup

· All changes made to either the configuration partition or the schema partition in Active Directory (such as schema changes)

· Additionally, any software applications that were running on the domain controllers will need to be reinstalled on the domain controllers after the forest is recovered.

Determining Which Backups to Use

To restore domain controllers, use backups that were taken a few days before the occurrence of the failure. In general, you need to trade off between recentness and safeness of restored data. Choosing a more recent backup recovers more useful data, but it might increase the risk of re-introducing dangerous data into the restored forest. 

It is strongly recommended that you keep detailed logs about the health state of Active Directory on a daily basis, so that in case of a forest-wide failure, the approximate time of failure can be identified.
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	You can cause Recovery Manager Forest Edition to use only backups taken before the specified date. Specify that date in the Use backups taken before text box, displayed in the Project Settings area in the console view. 


Selecting a Backup to Be Used
The Select Backup dialog box allows you to select an Active Directory backup to be used to recover a domain controller you select in the forest recovery project. 
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	You can select only backups registered in the Recovery Manager backup registration database. Recovery Manager must be installed on the computer that runs Recovery Manager Forest Edition.


To open the Select Backup dialog box
20. Open an existing recovery project or create a new recovery project.

21. In the application console, under Domain Controller(s) Recovery Settings, select the domain controller to be recovered, and then under Backup information, click Select Backup. 

The Select Backup dialog box is similar to the following screen.
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This dialog box defines the following elements:

· Registered backups For the selected domain controller, lists all backups registered in the Recovery Manager backup registration database. From the list, select the backup from which you want the domain controller to be recovered.

Changing the Project Settings
Once you have created a recovery project, you can change its settings such as the method of recovery for any domain controller the project contains, the credentials that the application uses to access the domain controller, etc.

To change a project settings

22. Using the application console, create a new recovery project or open an existing project. 

23. Under Project Settings, select the domain controller for which you want to specify the recovery settings, and then under Domain Controller(s) Recovery Settings change the appropriate settings. 

24. Repeat Step 2 for each domain controller for which you want to modify the recovery settings.

Recovery Steps

To recover the Active Directory forest, open Forest Recovery console, and perform the following steps:

25. Open the recovery project you have created for your environment (see "Creating or Opening a Recovery Project" earlier in this paper).

26. Using the logs about the health of Active Directory, determine the forest failure date. Specify that date in the Use backups taken before text box displayed in the Project Settings area in the console view. 

27. Verify the recovery project settings for each domain controller in the forest. To do this, in the console view, under Project Settings, do the following:

· In the domain controllers list, click a domain controller, and then verify the settings displayed under Domain Controller(s) Recovery Settings. Change the settings, if necessary. Repeat this operation for each domain controller the project includes.

28. On the toolbar, click Start Recovery to start the recovery process.
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	Before starting the recovery process, it is strongly recommended that you test the forest recovery project by clicking Test on the toolbar. For more information, see "Using the Test Mode" earlier in this paper.


Viewing the Recovery Operation Progress

While performing the forest recovery, the application allows you to see the progress of the recovery operation for each domain controller to be recovered.

To view the recovery operation progress for domain controller(s)

· In the console view, under Project Settings, select domain controller(s) of interest. The current information on the recovery operation for selected domain controller(s) is displayed under Domain Controller Recovery Progress.
Reporting on the Forest Recovery Results

After termination of the forest recovery operation, analyze the forest recovery report. The report contains information about the forest recovery results including a list of domain controllers that were not recovered.

To view the recovery operation report

· On the toolbar, click View Report.

In the report, the domain controllers that were not recovered are listed under Failed Domain Controllers. In the list, each entry includes the following information:

· Domain controller name

· The failure reason
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	When restoring the forest, the application makes irreversible changes to the forest structure. However, before performing post-recovery steps, you still can retry the recovery operation for failed domain controllers.


Retrying the Recovery Operation

For each "failed" domain controller listed under Failed Domain Controllers we recommend that you investigate the failure reason. 

Make sure that the failed domain controller is connected to the network. Verify the recovery settings specified for that domain controller.

To view recovery settings for a domain controller

· In the console view, under Project Settings, select the domain controller. The recovery settings for the selected domain controller are displayed under Domain Controller(s) Recovery Settings.
Try to determine the failure reason and resolve that problem, if possible. After this, retry the recovery operation.

To retry the recovery operation for a domain controller

· In the console view, under Project Settings, right-click the domain controller, and then click Retry operation on the shortcut menu.

Post-Recovery Steps

To complete the forest recovery operation, Recovery Manager Forest Edition performs the following steps:

29. Removes any information about the failed domain controllers from Active Directory.

30. Tries to assign the FSMO roles taken by failed domain controllers to recovered (succeeded) domain controllers.
31. Configures some of the recovered domain controllers as global catalog servers, if necessary.
Note that the post-recovery operation does not start automatically, if the application failed to recover some of domain controllers the forest recovery project includes. Before manually starting the post-recovery operation, retry the recovery procedure for failed domain controllers (see "Retrying the Recovery Operation" earlier in this paper).

To manually start the post-recovery operation

· On the toolbar, click Finalize Recovery.
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	After performing post-recovery steps, the failed domain controllers will be completely removed from the forest. To replace those domain controllers, you should add additional domain controllers to the domains using the DCPromo.exe.

For more information about how to add additional domain controllers, consult Microsoft TechNet Library.


Glossary

A
Active Directory
The Windows-based directory service. Active Directory stores information about objects on a network and makes this information available to users and network administrators. Active Directory gives network users access to permitted resources anywhere on the network using a single logon process. It provides network administrators with an intuitive, hierarchical view of the network and a single point of administration for all network objects.
Active Directory Schema
The Active Directory schema defines the set of all object classes and attributes that can be stored in the directory. For each object class, the schema defines what attributes an instance of the class must or may have and specifies the legal parents of the class. The Active Directory schema is stored in the directory as specific schema objects that are protected with access control. Schema objects can be accessed and updated dynamically.

Administrator
A user account that is a member of the Administrators group and therefore has administrator privileges in a Windows 2000 or Windows NT domain. An administrator has full control for all the domain resources.

Application Directory Partition
An Active Directory directory partition that stores application-specific data that can be dynamic (subject to Time to Live restrictions). Application directory partitions can store any type of object except security principals and are not replicated to the global catalog. The replication scope of an application directory partition can be configured to include any set of domain controllers in the forest.
B

Backup
A duplicate copy of a program, a disk, or data, made either for archiving purposes or for safeguarding valuable files from loss in case the active copy is damaged or destroyed. Recovery Manager Forest Edition uses Active Directory backups created with Quest Recovery Manager for Active Directory.
C
Container Object
An object that can logically contain other objects. The objects created or placed in a container object are referred to as the container's child objects, and the container object is referred to as their parent object. For example, an Organizational Unit is a container object. An object can have only one parent container.
D
Directory Object
In a Windows 2000/2003 Active Directory domain, any object stored in Active Directory. See also Network Object.

Directory Partition

A contiguous subtree of Active Directory that is replicated as a unit to other domain controllers in the forest that contain a replica of the same subtree. In Active Directory, a single domain controller always holds at least three directory partitions: schema (class and attribute definitions for the directory), configuration (replication topology and related metadata), and domain (subtree that contains the per-domain objects for one domain). Domain controllers running Windows Server 2003 can also store one or more application directory partitions.
Domain
In a Windows NT/2000-based network, a domain is a named set of computers that share a common directory database. A domain provides centralized user and group accounts with access to network resources. Each domain has its own security policies and security relationships with other domains, and represents a single security boundary of a Windows NT/2000-based network. Active Directory is made up of one or more domains, each of which can span more than one physical location. Each domain has a unique name.

Domain Controller
In a Windows 2000/2003 domain, the server that manages user access to a network, which includes logging on, authentication, and access to the directory and shared resources. A domain controller maintains the security policy and the Security Accounts Manager (SAM) database for a domain. A Windows NT domain has one primary domain controller and can have multiple backup domain controllers. A Windows 2000/2003 domain can have multiple domain controllers acting as peers.
Domain Tree
A domain tree is comprised of several Windows 2000 domains that form a contiguous namespace, sharing a common schema and configuration. Domains in a tree are also linked together by two-way, transitive trust relationships. Multiple trees can be connected to form a forest. Active Directory is comprised of one or more trees.

See also Forest.

F
Forest
A collection of one or more Windows 2000 Active Directory trees organized as peers and connected by two-way transitive trust relationships between the root domains of each tree. All trees in a forest share a common schema, configuration, and Global Catalog. When a forest contains multiple trees, the trees do not form a contiguous namespace.

G
Global Catalog
A server that holds a partial replica of every user-naming context in Active Directory. The Global Catalog also contains the schema and configuration naming contexts. The attributes in the Global Catalog are those most frequently used in search operations and those attributes that are required to locate a full replica of the object. The Global Catalog enables users and applications to find objects in Active Directory given one or more attributes of the target object, without knowing what domain holds the object.

L
Local Group
A local group can be granted permissions and rights only for its own computer on which the group resides. However, it can contain user accounts and global groups from its own domain and trusted domains. 
N
Naming Context 

See Directory Partition.

Network Object
A directory object or computer resource. See Directory Object.

Non-Transitive Trust Relationship
A trust relationship that is bounded by the two domains in the relationship. For example, if domain A trusts domain B and domain B trusts domain C, there is no trust relationship between domain A and domain C. A non-transitive trust relationship can be a one-way or two-way relationship. Only non-transitive trust relationships can exist between a Windows 2000 domain and a Windows NT domain, or between Windows 2000 domains in different forests. See also Trust Relationship and Transitive Trust Relationship.

O
Object

An object is a named set of attributes that represents something concrete, such as a user, a printer, or a computer system. The attributes hold data describing the subject that is identified by the object. For example, attributes of a user might include the user's given name, surname, and e-mail address.

Organizational Unit (OU) 

An Active Directory container object defined in a Windows 2000 domain, an organizational unit is a logical container into which users, groups, computers, and other organizational units are placed. It can contain objects only from its parent domain. Normally, an organizational unit represents a scope over which administrative control is delegated.
P
Primary Domain Controller
In a Windows NT domain, a domain controller that maintains the master copy of the Security Accounts Manager (SAM) database. The primary domain controller is the only computer that directly receives the changes made to the SAM database. Within a domain, the primary domain controller periodically replicates its data to the other domain controllers, known as backup domain controllers.
R

Recovery Project
The recovery project is where you manage the recovery of all the domain controllers in the forest to be recovered. The project also contains the list of domain controllers and settings you set up, such as the method of recovery for each domain controller, the credentials Forest Recovery uses to access the domain controller, etc. The project file (.FRPROJ file) contains information about the content and properties of your project.

S
Schema
See Active Directory Schema.
Security Accounts Manager

In Windows NT and Windows 2000, a protected subsystem that maintains the directory database and provides an application-programming interface (API) for accessing the database.
Service

A process that performs a specific system function and often provides an application-programming interface (API) for other processes to call.
Shared Resource (Share) 

Refers to a computer resource that is made available to network users, such as a folder, file, or printer.

Sub-Tree
An unbroken path in the tree, including all child objects of any container in that path. See also Tree and Domain Tree.

T
Transitive Trust Relationship
The trust relationship that inherently exists between Windows 2000/2003 domains in a domain tree or forest, or between trees in a forest, or between forests. When a domain joins a forest or a domain tree, a transitive trust is automatically established. Transitive trusts are always two-way trust relationships. See also Domain Tree, Forest, and Non-Transitive Trust Relationship.
Tree
Tree is usually used to describe a hierarchy of objects. Nodes in the tree (points at which the tree branches) are container objects. For example, a computer network or domain is a container object. A tree shows how objects are connected or the path from one object to another. A contiguous sub-tree is any unbroken path in the tree, including all child objects of any container in that path.

Trust Relationship
A logical relationship established between domains that allows pass-through authentication in which a trusting domain honors the logon authentications of a trusted domain. User accounts and global groups defined in a trusted domain can be granted rights and permissions in a trusting domain, even though the user accounts or groups do not exist in the trusting domain's directory.
Trusted Backup
An Active Directory backup that contains no dangerous data.
Trusted Domain
See Trust Relationship.
Trusting Domain
See Trust Relationship.

Two-Way Trust Relationship
A link between two domains that allows each domain to trust user accounts in the other domain to use its resources. A user can log on from computers in either domain to the domain that contains the user's account. See also Trust Relationship.

U
UNC Name
A full Windows name of a shared resource on a network. It conforms to the \\servername\sharename syntax, where servername is the server's name and sharename is the name of the shared resource. UNC names of folders or files can also include the directory path under the share name, with the following syntax: \\servername\sharename\directory\filename

UNC is also called Universal Naming Convention.










